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Mandatory: Certificate should have key length value set to 1024

How To Install Certificate In Chrome




»  Click download and install certificate option and you would download the certificate.
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Please keep this window Open while you are Browsing. ...
Click here to LOGOUT

Session Time Remaining

00:23:02

Note : If your browser is inactive for more than 30 Mimutes, then you will be logged out.
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In Options visit the Under the Hood and Click on Manage Certificates.

@ Google Chrome Options

] |

| Basics | Personal Stuff | Under the Hood

You have chosen to open certain file types automatically after downloading
these settings so that downloaded files don't open automatically.

Clear auto-opening settings

Web Content

Change the default font and language for webpages.

’ Change font and language settings I

Gears: [ Change Gears settings I

Security

Select trusted 550 certificates.

Manage certi-ﬁcaty

Computer-wide 550 settings:
[7] UsessL20

Check for server certificate revocation

. ¥ou can clear

-

Reset to defaults




»  Select Trusted Root Certification Authorities & Click on import and select the certificate
file just downloaded.
€ Cortifcntes | . W i i — i

Intended purpose: <All = v]

| Intermediate Certification Autharities | Trusted Root Certification Authorities | Trusted Publ 4 | * |

Izsued To Issued By Expiratio...  Friendly Mame

F
55 class 3 Public Prima... Class 3 Public Primary ...  8/2/2028 VeriSign Class 3 ...
5;]class 3 Public Prima... Class 3 Public Primary ...  1/8/2004 VeriSign

_|_}'}|Cnpy'right {c) 1997 ... Copyright () 1997 Mi... 12311999 Microsoft Timest
L'T,JEquifax Secure Cer... Equifax Secure Certifi... 8/22/2018  GeoTrust
@gajshieldm gajshieldca 8/2/2015 <MNone >

@GTE CyberTrust Glo... GTE CyberTrust Globa... &/14/2018  GTE CyberTrust
@Micmsnﬂ: Authentic... Microsoft Authenticod...  1/1/2000 Microsoft Authe. ..
@Miuusnﬁ Root Aut... Microsoft Root Authority  12/31/2020  Microsoft Root A...
SIMicrosoft Root Cert... Microsoft Root Certifi...  5/10/2021  MicrosoftRootC... ~

Remove Advanced

Learn more about certificates

Close
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l'r‘b Certificate Import Wizard g

File to Import
Spedfy the file you want to import.

File name:

C:\Users'Sunny\DesktopGajshield. pem I Browse... |

Mote: Mare than one certificate can be stored in a single file in the following formats:
Personal Information Exchange- PKCS #12 (.PFX,.P12)
Cryptographic Message Syntax Standard- PKCS £7 Certificates (.P7E)

Microsoft Serialized Certificate Store (L55T)

Learn more about certificate file formats




fb Certificate Import Wizard

Certificate Store

Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate stare, or you can specify a location for
the certificate,

() Automatically select the certificate store based on the type of certificate
i@ Place all certificates in the following store
Certificate store:

Trusted Root Cerﬁﬁ;%jég-ﬁ;uﬁ:l;ri_ﬁes Browse. .. |

Learn more about certificate stores
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fig Certificate Import Wizard M\

Completing the Certificate Import
Wizard

.f'r: | The certificate will be imported after you dick Finish,

You have spedfied the following settings:

Certificate Store Selected by User RVl d o= gl

Content Certificate
File Mame C\UsersiSunnyiDesk

F B Tl |
Certrficate Import Wizard u
.
@I The import was successful.
§
| oK "
e . £

A Once this step is done, you have installed the CA into your browser and now the browser
would accept firewall certificates.



How To Install Certificate In Internet Explorer

These browsers use windows built in Certificate credentials and for them you will have to add
the certificate into the system. Here is how:

»  Download the certificate in pkcs#12 format.

3 https://192.168.2.199 - GajShield Info... E”E”E

GajShield Infotech (I) Pvt. Ltd.

Click here to LOGOTT
Session Tine Eematning

00 =25 53

Mate : If vour browser 13 mactive for more than 30
Mlimtes, then you will be logged out.

Hitps proay 13 enabled, to avoid frequent certificate
errors download and mstall cert:iﬂcati

& S @ Internet

A Instart->run type mmc.



= Run u

Type the name of a program, folder, document, or Internet
resource, and Windows will open it for you.

Cancel | | Browse...

A Once mmc is opened, add certificates option from File->Add/remove snap-in.

@ Consolel - [Console Root] - | ] =B

File | Action View Favorites Window Help (= [[=]x]
g New Ctrl+N
E Open... Ctrl+0 T
Save Ctrl+S

pl gakl
More Actions b

Save As... There are no items to show in this view,

Add/Remove Snap-in... Ctrl+M
Options... {':?

1 services

2 compmgmt

3 devmgmt
4 diskmgmt
Exit
L
]
|
| |Enables you to add snap-ins to or remove thern from the snap-in console.




r Bl
AddorRemuveSnap-]ns‘ — - M

‘You can select snap-ns for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled.

Available snap-ins; Selected snap-ins:
Snap-in Vendar = [ Console Root Edit Extensions...
= ActiveX Control Microsoft Cor...

. Remaove
Aumnrization Manager Microsoft Cor...

= Certificates Micrasoft Cor...
- "

. Component Services  Micrasoft Cor... Move Up
%EComputer Managem... Micosoft Cor...

m

24 Device Manager Microsoft Cor... | | MGE
=7 Disk Management Microsoft and. ..
Event Viewer Microsoft Cor...
| Folder Microsoft Cor...
EJ' Group Policy Object ... Microsoft Cor...
.g IP Security Monitor Microsoft Cor...
@ IP Security Policy M...  Microsoft Cor...
2 Link to Web Address ~ Microsoft Cor...  _ At
- T “ = el -
Description:

The Cértiﬁmtes snap-n allows you to browse the contents of the certificate stores for yourself, a service, or a computer.

[ ok || concel

r

— — b
Certificates snap-in M

This snap-in will always manage cedificates for:
(71 My user accourt
(71 Service account

i@ Computer account

¢ Back [ Nead >’I“'] [ Cancel _
Y




Select Computer - e s

Select the computer you want this snap-in to manage.
This snap4n will ahways manage:

@ Local computer: the computer this console is running on)
(71 Ancther computer: Browse...

[] Allow the selected computer to be changed when launching from the command line. This
anby applies if you save the console.

| <Back | Fnish [hy| Cancel

i

»  Once certificates are added, click on OKk.



»  Expand certificates and right click on Trusted Root Certification Authorities, select All
task and click on Import.

Consolel - [Console Roof\Certificates (Local Computer]\Trusted Root Certification Authorities\Certificates] =

File Action View Favorites Window Help I
es 2B olc= HBE

| Console Root Issued To - Issued By Actions

a G Ceiicales Lo Compitiey 5] Class 3 Public Primary Certificat... Class 3 Public Primar|| Certificates
b L] Personal [5]Class 3 Public Primary Certificat... Class 3 Public Primar '

] Copyright () 1997 Microsoft C..  Copyright () 1997 M

More Actions

4 || Trusted Root Certification Authorities

5 j: i—:;terprise All Tasks ] Import... Equifax Secure Certifi
b [ Intesmedia = : ertru oba GTE CyberTrust Glob)
5 B Tosted Pi ] ft Authenticode(tm) Ro... Microzoft Authentice
b TI Untrusted New Window from Here oft Root Autherity Microsoft Root Authi
b 3 Third-Party New Taskpad View... oft Root Certificate Auth... Microsoft Root Certif
b [ Trusted Pe BILITY ACCEPTED, (c)97 ... NO LIABILITY ACCEP
& 7] Remote De Refresh Premium Server CA Thawte Premium Ser
[ [ Smart Carg Export List... Timestarmping CA Thawte Timestampir
[ | Trusted De Hel SERFirst-Object UTMN-USERFirst-Obje
elp

Tl 1 | v ] T b

Add a certificate to a store




A Import the pkcs#12 format (.p12) certificate and when prompted on where to save the
certlflcate select the Trusted Root Certification Authorities path and click on Next.

l‘f.ertlfcate Import Wizard “ g

Welcome to the Certificate Import
Wizard

y This wizard helps you copy certificates, certificate trust
| lists, and certificate revocation lists from your disk to a
— certificate store.

A certificate, which is issued by a certification authority, is
a confirmation of your identity and contains information
used to protect data or to establish secure network
connections. A certificate store is the system area where
certificates are kept, L

To continue, didk Next,

< Back [ Mext }JH)[ Cancel
My




, .
Certificate Import Wizard S ==

File to Import
Spedfy the file you want to impart.,

File name:

C:\Usersisunny \DesktopGajshield. pem I Browse... I

Mote: More than one certificate can be stored in a single file in the following formats:
Personal Information Exchange- PRICS #12 ((PFX,.P12)
Cryptographic Message Syntax Standard- PKCS #7 Certificates ((P7E)
Micrasoft Serialized Certificate Stare ((55T) L

Learn more about certificate file formats

<Back || Next::‘!-}n;l[ Cancel




Certificate Import Wizard 5 —— M

Certificate Store

Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can specify a location for
the certificate.

(7 Automatically select the certificate store based on the type of certificate
@ Place all certificates in the following store

Certificate store:

Trusted ﬁﬁéf-cérﬁﬁmﬁun Authorities

Learn more about certificate stores

< Back ” Next}%[ Cancel
kit

L

o Click on Finish to complete the installation process



fb Certificate Import Wizard

T —

Completing the Certificate Import
Wizard

The certificate will be imported after you dick Finish.

¥ou have spedfied the following settings:

Cerfificate Store Selected by User @E0Hi=s LGl da= i)l

Content Certificate
File Mame C:Wsers\sunny\Desk

W o Ty ———

| <Back | Finish Cancel

L

.
Certrficate Import Wizard

|

@ The import was successful.

Lok Jf




File  Action

|

View Favorites Window Help

B4 XE= BE

| Console Root

» | Personal

4 E—ﬁl Certificates (Local Computer)

4 || Trusted Root Certification Authorities
|| Certificates

i || Enterprise Trust

& ] Intermediate Certification Authorities

|| Trusted Publishers

i [ Untrusted Certificates

[+ || Third-Party Root Certification Authoritis

b [ Trusted People

» || Remote Desktop

[ Smart Card Trusted Roots

] Trusted Devices

Issued To

[5] Class 3 Public Primary Certificat...
(5] Class 3 Public Primary Certificat...
5] Copyright (c) 1997 Microsoft C...
5 Equifax Secure Certificate Auth...
E= gajshieldca

GTE CyberTrust Global Root

@ Microsoft Authenticode(tm) Ro...
S Microseft Root Authority

I Microsoft Root Certificate Auth...
5/ NO LIABILITY ACCEPTED, ()97 ...
[ Thawte Premium Server CA

[ Thawte Timestamping CA

5] UTMN-USERFirst-Object

4|

e

| )] "

Issued By

Class 3 Public Prirar,
Class 3 Public Primar
Copyright (c) 1997 M
Equifax Secure Certifi
gajshieldca

GTE CyberTrust Glob)
Microsoft Authentice
Microsoft Root Authi
Microsoft Root Certif
MO LIABILITY ACCEP
Thawte Premium Ser
Thawte Timestampir
UTM-USERFirst-Objes

More Actions

Mere Actions

_W -

-

Trusted Root Certification Authorities store contains 13 certificates.

A Once this step is done, you have installed the CA into your browser and now the browser

would accept firewall certificates.




How To Install Certificate In Mozilla Firefox

»  Click download and install certificate option and you would download the certificate.

%3 GajShield Infotech (1) Pvt. Ltd. - Mozill.. E]@-

ﬁ https ,l',|'192 168 2 19'§J,l'n:g| I:nn,l'user sessn:nn ggl?gl 5?38262 :

GajShield Infotech (I) Pvt. Ltd.

FPleasze keep this window Open while yvou are

Clicle here to LOGOTTT

=esston Time Eemaming

00:29:35

Hote : If wour browser 15 mactive for more than 30
Ifinutes, then wou will be logged out

Hittps promy iz enabled, to avedd frequent certificate
errors download and mstall cerﬁﬂcatﬁr')

Stopped 192.165.2,199

Visit preferences (under Tools -> Options in windows and Edit -> Preferences in Linux).

@ GajShield Infotech (I} Pvt. Ltd. - Moxzilla Firefox [ a

File Edit View History Bookmarks Help

- o ‘M Web Search Ctrl+K et

2, Most Visited | | Getting Started 5, |  Qownloads S {

— Add-ons &

| @ GAISHIELD = | % | i GajShield Infotech (I) Pvt. Ltd.
— = = | Error Console Ctrl+Shift+J -

Page Info

afotech (I) Pvt. Litd.

Start Private Browsing Ctrl+Shift+P
Clear Recent History... Ctrl+Shift+Del

Options... Ap”l‘r\
L)

Login

x |ot

i '-"_- Google

L= | B

P




»  In preferences visit the Advanced option and select the Encryption tab.

el O @ W] e & 4@

Main Tabs Content  Applications Privacy  Security  Adwvanced

' General | Metwork | pdate | Encryption |

Protocals -

[#]:Use 551 3.0 Use TLS 1.0

- Certificates
‘When a web site requires a certificate:

(®) Select one aukomatically () Ask me every time

['-.-'iew CertiFicateg] [Bew:u:ati-:un Lists ] [ Yalidation ] [Securitg Devices

Ik l [ Cancel ] [ Help




»  Click on view certificates.

W O @ E & & o

Main Tabs Content  Applications Privacy  Security  Adwvanced

General | i\]etwu_rl-{ig Update | Encryption |

Protocals -

Use 550 3.0 Use TLS 1.0

- Certificates
‘When a web site requires a certificate:

(®) Select one aukomatically () Ask me every time

E'n-'iew CertiFicategil [Bew:u:ati-:un Lists ] [ Yalidation ] [Securitg Devices

[ Ik ] [ Cancel ] [ Help




»  Select Authorities & Click on import and select the certificate file just downloaded.

©J Certificate Manager ;| |E| |E|

'Your Certificates | Peaple | Servers | Authorities! | Others |

vou hawve certificates on file that identify these certificate authorities:
Certificate Mame Securiby Device |52l
[=] ABA ECOM, TNC, X
ABA.ECOM Rook C4 Builtin Object Token =
[= AC Camerfirma 34 CIF ASZ743287
~Zhambers of Commerce Rook Builkin Object Token
ialobal Chambersign Rook Builkin Object Token
[= &ddTrust AB
AddTrust Class 1 CA ook Builtin Object Token
< AddTrusk External & Rook Builkin Object Token
- AddTrust Public C& Riook Builkin Object Token
AAdTrusk Onalified CA Rank Builrin Ohiect Taken fut
Import...




Select File containing CA certificate(s) to import

Laok in: | (E} Desktop v | 5 i B -
ﬂDMy Documents z! | ~fwtainstalcertificate-help
4 23 *J My Compuber igl‘-_].|:'.|:||:|Ii|:ati|:|n latter
My Fecent ‘-:-!My Metwork Places asdl.evt
Documents @.ﬁ.nti\a‘ir PE Classic asd.evt
= Fwant Browser @DEEF‘A
[ EFlack E@E-mail
Desktop = gajshield ajshield. pem
A9 Gajshield VPN Clisnt Gajshield_old. pern
- = LZTP anugletalk—setup
] o LZTPEIO SR caToMeeting
@Mc@illa Firefox 3 Beta 2 I%f]u;u_ljarath dei
by Documents . e
é;l'opera @hDWtDII‘lSta"EErtIFIEatE-hE|D
58 Safari ) Maxthanz
gg IiLicense File Bl Merrut Atten Farmat 29th April '09(1)
i [ Mew Falder B Merrut Atken Format 28th April '09(1)(2
My Computer |m= ey Folder (2) B MONTHLY_EXPENCE
9 ‘ :
by Metwork File name: |Gai5hield w | [ Open ]
Places :
Files af type: |.-'.‘-.II Files W | [ Cancel ]

Downloading Certificate

Yol have been asked to trust a new Certificate suthaority (CA7,

Do wou want to trust "gajshieldca” For the Following purposes?
Trusk this CA koidentify web sites,

Trust this C4 ko identify email users,

[+]: Trusk this CA ko identify software developers,

Before trusting this 4 for any purpose, vou should examine its certificate and its policy and
procedures (if available),

Excamine C certificate

(] 4 _] [ Cancel




©J Certificate Manager

Your Certificates | People | Servers | futharities | Cthers |

¥ou have certificates on file that identify these certificate autharities:

Certificate Mame Securiby Device )
iEquifax Secure Global eBusiness CA-1 Builtin Object Token »
Equifax Secure eBusiness CA-1 Builkin Object Token

[# gajshield. gajshield. com
[=] GeaTrust Inc,

i-aeaTrust Global A Builkin Object Token

i-izeoTrust Global CA 2 Builtin Object Token

i-GeaTrust Universal Ch Builkin Object Token

weimenTrosk Lniversal Ca = Buiiltin Ohierck Taken it
[ ViEw. . ] [ Edit... ] [ Impart... ] [ Expoart.. ] [ Delete. .. ]

A Once this step is done, you have installed the CA into your browser and now the browser
would accept firewall certificates.




How To Install Certificate In Opera
»  Click download and install certificate option and you would download the certificate.

T — . oS W

,_‘:| = | l’i |2 |i_ 3 https://192.168.2.193/cgi-bin/user_session.ggi alv :".l' Search
Ii-l_:i Do you want Password Manager to save the password for this site? "] Remember ch

GajShield Infotech (I) Pvt. Ltd.

Please keep this window Open while you are Browsing. .._...
Click here to LOGOUT

Session Time Remaining
00:29:49

Note : If vour browser is inactive for more than 30 Minutes, then you will be logged out.

Hittps proxy is enabled, to avoid frequent certificate errors download and install cerﬁﬂcalﬁ

»  Visit preferences under Tools and select the Advanced tab.

Preferences

Gerneral | Wand | Search | eb Pages | Advanced

Tahs

Browsing Seft Master Password. ..
Motifications

Ask For password
Cankenk
Fanks
Downloads
Prograrns

History

' Enable Fraud Proteckion
Cookies

Security

higtiark Manage Certificakes. ..

Toolbars
Shartcuts
Yoice Security Protocols. ..




»  Select the Security option and click on the Manage certificates.

Certificate Manager

ersonal | Autharities | Intermediate | Approved

~Client Certificate Issuer Wigw, .,

Delete

Impoark... .
Expork.. @

Client certificates identify wou during transactions with secure Web sites




A Go to the Authorities tab and click on the Import and select the certificate file just
downloaded and then click on Install.

Certificate Manager
Inkermediate | Appro

~Certificate Authority Wigw, ,, .
AddTrust External CA Rook

COMODO Certification Authority Delete |
DigiCert High Assurance EY ook CA

Entrust Global Secure Server Certification Authority
Entrust Rook Certification Autharity

Entrust Secure Server Certification Sutharity Export... |
Equifax Secure Certificate Autharity

GeoTrust Primary Certification authority

zlobal3ign

alobal3ign Rook CA

GTE CyberTrust Global Roak

Thawke Premium Server Ch

thawte Primary Rook C4

Thawte Server CA

Yalicert Class 2 CA

Yerisign Class 3 Public Primary Certification sukharity

Yerisign Class 3 Public Primary Certification Authority - G5

Certificate Autharities certify the identity of Web sites




Import Certificate

Look jn; | @' Dezktop

v @ % =@

?X

F[ § EHDEk

Deszktop

& L2TP

by Documents Eg
Opera

58 Safari

ty Computer

£

Ty (L )My Documents
ub 'j My Computer
My Recent HM&# Metwork Places
Documents  [®d antivir PE Classic

— Fwant Browser

= gajshield
A9 Gajshield VPN Clisnt

__'_f = LZTPEID

&}Muzuzilla Firefox 3 Beta 2

EIJ ICLicense File
' IiMew Folder

[CMew Folder (2)
-—:5_E~$wtu:uinsta||-:ertificate-help
| ~aRLOB 19, Emp

| ~WRLO923, Emp

o ~AWRL1E44, Emp

I@I].|!'.|:||:|Ii|:.5|ti|:|n |atker
asdl.ewt
asd.evt
BnEERs

E@E-mail
Gajshield,pem
ajshield_old. pem
anngletalk—setup
EBGDTDMeeting
|E—II._f]u;|ujaralzh dei

-
g File name:

by Metwork, Files of type:

Install Certificate

<localhost =

Certificate autharities certify the identity of Web sites, You should

only install certificate authorities from sites wou brust,

gajshieldca




Install Certificate

ﬂ Are vou sure you want to krust this issuer?

Certificate Manager

Personal | author Intermediate | Approved | Rejected

+Certificate Authority Wig, ., [
AddTrust External CA Rook
COMOD Cerkification Authoriky
DigiCert High Assurance EY Root CA
Enkrust Global Secure Server Certification Autharity Impart... |
Entrust Root Certification Autharity T T T
Enkrust Secure Server Certification Authoriby Export.. |
Equifax Secure Certificate Authariky

gajshieldca

Delete

GeoTrust Primary Certification Authority

alobal3ign

GlobalSign Root C4

GTE CyberTrust Global Rook

Thawte Premium Server Co

thawte Primary Fook CA

Thawte Server CA

Walicert Class 2 CA,

Yerisign Class 3 Public Primary Certification Authority
YeriSign Class 3 Public Primary Certification Authority - G5

Certificate futhorities certify the identity of \eb sites

A Once this step is done, you have installed the CA into your browser and now the browser
would accept firewall certificates.




How To Install Certificate In Safari

»  Click download and install certificate option and you would download the certificate.

[ GajShield Infotech )

l - | > | | + |8 https://192.168.2.199/cgi-bin/user_session.ggi & G] [Q' Google | O~ %~
[I] &% Apple Yahoo! GoogleMaps YouTube Wikipedia MNews (10} ¥ Popular v
Apple - Start | Gajshield Infotech @ P.. |- +

GajShield Infotech (I) Pvt. Ltd.

Please keep this window Open while you are Browsing.......
Click here to LOGOUT

Session Time Remaining
00:29:17

Note : If your browser is mactive for more than 30 Minutes. then you will be logged out.

Hitps proxy is enabled, to avoid frequent certificate ms&)wnbadmdmstﬂ@ﬁ!

»  Visit preferences (under Tools ->)

GAJSHIELD = -
[© -

|. a4 |» ‘ | ks |. http://www.gajshield.com/manual/sunny/web/pagel0.htrm ¢ | {0.' Google | (LR *'l
m Apple Yahoo! GoogleMaps YouTube Wikipedia Mews(12) ¥ Popular ¥ Show Menu Bar
GajShield - Unified Thre,, | GAISHIELD & | Hide Bookmarks Bar Crl+Shift+B
Show Status Bar Ctrl+/
Gontat | HideTab Bar Crl-Shift=T
GAJSHIELD i Tt
Home Aboutlls Products ¥ Solutions ~ Partners v | Support T H History Ctrl+H
Downloads Chrl+Ali+L
Private Browsing...
GajShield Sixth Sense UPTM s
Block Pop-Up Windows Ctrl+Shift+K
A et 3 " .y . Preferences.., Ctrl+,
GajShield’s technically innovative solutions are
setting the trend for modem Internet Help F1
Data Leakage Prevention and Threat Mitigation Report Bugs to Apple...
About Safari




A

In preferences visit the Advanced option and Click on Change Settings.

Advanced !

j@u@

General Appearance Bookmarks Tabs R55  AutoFill Securty

Universal Access: || Mever use font sizes smaller than :EI |

[7] Press Tab to highlight each item on a webpage

2

Q&

Advanced

Style sheet: [ Mone Selected

-

Proxies: [ Change Settings... El

D Show Develop menu in menu bar

@




»  Click on Content and Certificates.

.‘ et e

| General | Security | Privacy | Content | Connections | Programs I Aduanced|

Parental Controls
& Control the Internet content that can @Parenbl Controls |

be viewed. I
Content Advisor
@ Ratings help you contral the Internet content that can be
viewed on this computer.,

’ @Eﬂaﬂe ) ] | '“‘:--Setﬁngs |

Certificates ’
I - Use certificates for encrypted connections and identification.
. A N
_ | Cearssistate ||  Certificates ||  Publishers |
' q
AutoComplete e |
= = AutoComplete stores previous entries [ settings l I'
E on webpages and suggests matches
for you,
Feeds and Web Slices |
E Feeds and Web Slices provide updated [ Settings l
=] content from websites that can be
read in Internet Explorer and other '
programs,
| |
| |
(]34 ] [ Cancel l I_ Apply J !




»  Select Trusted Root Certification Authorities & Click on import and select the certificate

file just downloaded.
L —— o e

[a:n.n; v]

ﬁ?‘__. Certificates

Intended purpose:

[ Intermediate Certification Authorities | Trusted Root Certification Authorities | Trusted Publ * | * |

Learn more about certificates

Issued To Issued By Expiratio...  Friendly Mame i
mclass 3 Public Prima... Class 3 Public Primary ... &/2/2028 VeriSign Class 3 ...
E-H]CIBSS 3 Public Prima... Class 3 Public Primary ... 1/5/2004 VeriSign

[l copyright (c) 1997 ... Copyright () 1997 Mi...  12/31/1999 Microsoft Timest... |5
|_'_'B_|Equifax Secure Cer... Equifax Secure Certifi... 8222018  GeaTrust
@gajshieldm gajshieldca 6,/3/2015 <Mone =

[5,IGTE CyberTrust Glo... GTE CyberTrust Globa... 8/14/2018  GTE CyberTrust ...
@Min:rusuﬂ: Authentic,.. Microsoft Authenticed...  1/1/2000 Microsoft Authe...
@Miansuﬂ: Root Aut... Microsoft Root Authority  12/31/2020  Microsoft Root A...
L:‘;JMicrnsuﬁ Root Cert... Microsoft Root Certifi,..  5/10/2021  Microseft RootC... =

i Export... Remowve
Cerﬁﬁmte ded purposes

View




Open eS|
@O}L’Eaﬂop : — ,I. i?_|.| Search Deskmp_ P_|

Organize Mew folder - O @
B Deskt I FITE TOTaer
& Downloads L | BMC Utaking
“El Recent Places I TIF File
| B2Z3KB
:ﬁ Libiraries Free PDF to Word Doc Converter
@ 1 o\ Shortcut
=| Documents ¥ 100KE
Musi L
f Eons .. Gajshield.pem
[ Pictures = PEM File
B8 Videos 1.00 KB
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ib Certificate Import Wizard M

File to Impaort
Specify the file you want to impart.

File name;

C:YUsers\Sunny\Desktop\Gajshield. pem I Browse. .. I

Mote: More than one certificate can be stored in a single file in the following formats:
Personal Information Exchange- PKICS £12 (.PFX,.F13)
Cryptographic Message Syntax Standard- PKICS #7 Certificates (.P7B)

Microsoft Serialized Certificate Store (55T)

Learn more about certificate file formats
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Certificate Store

Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can spedfy a location for
the certificate,

() Automatically select the certificate store based on the type of certifiate
(@ Place all certificates in the following store
Certificate store:

Trusted Root Ceri:-ii"-i;i:i-t-:n_ﬁ;uﬂmriﬁes Browse...

Learn more about certificate stores
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Completing the Certificate Import
Wizard

.f‘r: | The certificate will be imported after you didk Finish,

You have specified the following settings:

Certificate Store Selected by User @ETi=sE s @0 g1}l

Content Certificate
File Mame C:YUsersiSunny\Desk

F B Tl |
Certrficate Import Wizard u
.
@I The import was successful.
§
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A Once this step is done, you have installed the CA into your browser and now the browser
would accept firewall certificates.



